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Introduction
WorldFAQ (World Frequently Asked Questions, pro-
nounced world-fack') is a collection of information about
places around the world, information such as time zones,
daylight savings time dates and times, currency exchange
rates, latitudes and longitudes, telephone dialing codes,
airport names and codes, populations, and more. Using this
information, you can calculate dates and times around the
world (both absolute and relative), currency conversions,
and distances between cities.

The WorldFAQ database has four different types of loca-
tions: countries, time zones, islands, and cities.  Islands are
bodies of land, such as Tahiti, that are part of a country
(French Polynesia in this case) but have different time zone
information. Islands such as Madagascar, that are self-con-
tained countries, are categorized as countries.

The full WorldFAQ database contains more than 200
countries, 57 time zones within those countries, 42 islands,
and 385 cities. The demo version of WorldFAQ contains an
assortment of 130 locations.

WorldFAQ knows about the relationships between these
four types of locations. It knows that Paris is a city in
France. It also knows, for instance, that the United States
has several times zones, and that several countries in Eu-
rope have the same starting and ending days for Daylight
Savings Time.

You can edit the data for each location so that, for exam-
ple, when the exchange rate for the Australian dollar chang-
es, you can enter the new rate for Australia. Because the
world is a relatively stable place, however, you cannot
change the relationships between locations. France will
probably always be a country in the European daylight
savings time region, Paris will probably always be in France,
and Mountain Time will probably always be a time zone in
the United States.

When you change the data for a location, it is properly
reflected in the location relationships stored in the World-
FAQ database. When you change the Australian exchange
rate, if you do a currency conversion for a city in Tasmania,
an island of Australia, that conversion uses the latest Aus-
tralian rate. Likewise, if you change the daylight savings
time start and stop dates for the United States, the daylight
savings time start and stop dates change for every US time
zone that operates under Daylight Savings Time, and every
city in those time zones.

System Requirements
WorldFAQ requires PalmOS version 2.0 or greater. This is
the version of the OS included with the PalmPilot Personal

and Professional Editions, and with Palm’s 1 MB Profes-
sional Upgrade for the Pilot 1000, 5000, and Personal orga-
nizers.

You can find out which version of the PalmOS your
PalmPilot connected organizer has by running the Memory
application. The OS version appears in the upper right-
hand corner of the Memory screen.

The WorldFAQ program file takes about 52 KB of RAM.
The full database, with about 700 locations in it, takes
about 44 KB of RAM.

In order to get the most out of this program and this
documentation, we strongly recommend that you read the
documentation that came with your PalmPilot device. In
particular, you should be familiar with starting applications
from the PalmPilot Application picker, using menus, and
editing text.

What’s Included
However you receive WorldFAQ, whether on floppy disk, by
downloading it from a Web site, or by some other means,
you should have five files:

• WFAQ.PRC, the WorldFAQ program that you install on
your PalmPilot organizer;

• WFAQDB.PDB, the WorldFAQ database;
• README.TXT, a text file containing last-minute

instructions or other details not included in the docu-
mentation;

• WFAQ.PDF, an Adobe Acrobat formatted file containing
this documentation; and

• LICENSE.PDF, an Acrobat format file containing the
licensing agreement governing your use of WorldFAQ.

Acrobat is a free, platform-independent document for-
mat with readers for the Macintosh, Windows, and UNIX
operating systems. If you don't have the Adobe Acrobat
reader for your system, you can find it practically every-
where – CompuServe, American Online, and various web
sites, including Adobe's at www.adobe.com. We don't in-
clude it with WorldFAQ because of its size.

Installing WorldFAQ
You install the WorldFAQ demo just like you install any
other PalmPilot application, using the PalmPilot Install
program that is included with your PalmPilot desktop. We
don’t describe the installation process in detail because it
varies with different models. Refer to the documentation
that you received with your PalmPilot device for the correct
procedures.
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You have to install two files: WFAQ.PRC and
WFAQDB.PDB. You can install them in either order, at the
same time or separately. You can also install WorldFAQ on
a PalmPilot organizer that also has our World Time or
WorldFAQ Lite program. They should peacefully coexist.

If you find yourself reinstalling the WorldFAQ program
or database at some point, make sure you first delete the
WorldFAQ program or database that is already on your
PalmPilot organizer. You do this using the Delete Apps
function of the Memory application which is permanently
installed on your Pilot.

Getting Started
When you first start WorldFAQ, the main view, showing a
list of locations in alphabetical order, appears (see Figure
1). The first thing you should do is set your Home location.
Find a city, country, or time zone closest to your actual
home. There are three ways to do this:

• Scroll up and down through the main view a page at a
time using the scroll buttons located at the bottom
center of your PalmPilot’s case.

• Scroll up and down one line at a time using the single-
line scroll buttons (Figure 1 shows only the down
button. Once you move past the top of the list, a similar
up buttons appears as well).

• Enter the first few characters of the location’s name in
the Graffiti entry area. WorldFAQ searches for up to five
consecutive characters (one or two should be sufficient
to find most names).

If you use this third method, when you first enter a
character, the program waits a brief moment for a second
character to use as part of its lookup string. The lookup
indicator appears while it’s waiting. If you don’t enter a
character within that moment, the program assumes that
you want to start over looking for a new location name and
the indicator disappears.

Once you find a location suitable for your Home, tap on
its name. A view similar to Figure 2, called a detail view,
appears. (What actually appears depends on whether you
tap a city, country, or time zone. See “Location Details” for
descriptions of the different detail views). You set that loca-
tion to your Home location by selecting Set Home from the
Locations menu,

then tapping the Done button, and finally, tapping the OK
button when WorldFAQ asks you if you want to save your
changes.

Figure 1 - WorldFAQ’s main view. Figure 2 - A city detail view.
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At this point, WorldFAQ assumes that the clock setting
on your PalmPilot organizer is the current time at your
Home. It returns to the main view and redisplays the loca-
tions list. For each location, it calculates the date and time
relative to your Home location (see Figure 3). It also dis-
plays your Home location at the top of the screen.

WorldFAQ’s Views
WorldFAQ actually has four main views – time, relative
time, currency, and distance – each showing a different type
of information. You can select any of the main views using
the View menu,

or you can tap one of the activators at the bottom of the
screen (refer back to Figure 1).

You can also change the font size for each main view
using the font controls shown in Figure 1. When using the
larger font, WorldFAQ may display less information be-
cause it has to fit fewer characters on each line. There are
also some preferences for controlling what appears in each
view. See “Setting Preferences” for more details.

The Time View
The Time view shows you the date and time for each loca-
tion in the main view (see Figure 3). You activate it by se-
lecting the Time command from the View menu or tapping
the time view activator on the bottom of WorldFAQ’s main
screen.

In time view, the date and time are formatted using the
formats that you set using the PalmPilot Prefs application.
WorldFAQ has full knowledge of world time zones and
Daylight Savings Time start and stop dates and times for
each location. If a location is currently operating under
Daylight Savings time, its name appears underlined.

The large-font view (see Figure 4) shows the current
time followed by a “+” to indicate a location that is current-
ly a day ahead of your Home location or a “-” to indicate a
location that is a day behind your Home location.

Locations that have more than one time zone, like Aus-
tralia, the Europe DST region, the United States, Canada,
and so on, do not show any values in the Time view. Just
their names appear.

The Relative Time View
The relative time view shows the date and time for all loca-
tions using a past or future date and time that you specify.
You activate it by selecting the Relative Time command on
the View menu or by tapping the relative time activator at
the bottom of the WorldFAQ main screen. When you select
relative time, the following dialog first appears:

Figure 3 - The time view, small font.

Figure 4 - The time view, large font.
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Use this dialog to select the date and time you want to use
to calculate the relative time. To select a calculation time,
tap the Time selector. The following dialog appears:

Select the time you want to use and then tap OK, or tap
Cancel if you decide you don’t want to change the time.

To select a calculation date, tape the Date selector. The
following dialog appears:

Select the date you want to use. Tap Cancel if you decide
you don’t want to change the date, or tap Today to select
today’s date.

After selecting a date and time, tap OK; the relative time
view appears (see Figure 5). WorldFAQ assigns the date and
time you select to your Home location and calculates the
date and time for all other locations relative to that date
and time for your Home location. The large-font view for
relative time is shown in Figure 6.

If you check the checkbox labeled “Show hour offsets,
not time.” on the relative time dialog box shown on the
previous page, WorldFAQ makes the same calculations, but

Figure 5 - Relative time, small font.

Figure 7 - Relative time, offsets, small font.

Figure 6 - Relative time, large font.

displays the results as hours and minutes ahead of or be-
hind the Home location. Figure 7 show the relative time
view with offsets.
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When calculating relative time, WorldFAQ always fac-
tors in the Daylight Savings Time rules in effect at the time,
using the start and stop dates currently stored in the World-
FAQ database.

Locations that have more than one time zone do not
show any values in the relative time view. Just their names
appear.

Currency
WorldFAQ can calculate currency amounts. You select the
currency view by selecting Currency from the View menu
or tapping the currency activator at the bottom of the
WorldFAQ main view. When you select the currency view,
the following dialog first appears:

Enter the amount you want to convert and then tap OK;
the currency view appears (see Figure 8). WorldFAQ assigns
the amount you enter to your Home location and calculates
same amount, using the exchange rates stored in its data-
base, for each location. The large-font view for the currency
view is shown in Figure 9.

If you tap “Show Exchange Rates” on the Currency Con-
version dialog box, WorldFAQ doesn’t calculate any curren-
cy conversions, but instead displays the exchange rates.
Figures 10 and 11 show the small and large-font currency
views with exchange rates.

Figure 8 - Currency view, small font.

Figure 9 - Currency view, large font.

Figure 10 - Currency exchange rates, small font.

Figure 11 - Currency exchange rates, large font.

Locations that have no exchange rate do not show any
values in the currency view. Just their names appear.
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Distance
The fourth and final WorldFAQ view is the distance view. It
displays the surface distance between locations using the
latitude and longitude settings for various cities and is-
lands. You activate it by selecting the Distance command
from the View menu. Figures 12 and 13 show the small and
large-font distance views.

Locations like time zones and countries, that don’t have
latitude and longitude, do not show any values in the Dis-
tance View. Just their names appear.

NOTE: Distances are calculated as a straight line be-
tween places. They typically won’t match flying or driving
distances.

Moving Around the World
WorldFAQ not only keeps track of your Home location, but
you can also use the program to track your movements
around the world using what is called your Current loca-
tion. The Current location is like your Home location, but
it’s temporary. Eventually, you go Home.

Figure 12 - Distance view, small font.

Figure 13 - Distance view, large font. Figure 14 - A typical edit view.

To set a Current location, you first need to identify it by
tapping on the location’s name in the main view. When you
do that, a detail view similar to Figure 14 appears for that
location. (What actually appears depends on whether you
tap a city, country, or time zone. See “Location Details” for
more information about the different location details.) You
set that location to your Current location by selecting Set
Current from the Locations menu,

tapping the Done button, and finally tapping the OK but-
ton when WorldFAQ asks you if you want to save your
changes.

At this point, WorldFAQ assumes that you want to move
to the Current location. It asks you if you want to reset the
system clock to the date and time it calculates the Current
location:

You can disable this option using the Preferences menu. See
“Setting Preferences” for more details).
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You can chose to have the program reset your clock to
the new time, or bypass resetting the system clock by tap-
ping Don’t Reset the Clock. This might be useful, for in-
stance, if you just want to do a quick currency or distance
calculation.

Regardless of the choice you make, WorldFAQ returns to
the main view and redisplays the locations list. Instead of
displaying the Home location at the top, however, the Cur-
rent location appears. All time, currency, and distance cal-
culations are now based on the Current location’s informa-
tion.

Eventually you will want to go Home. You do this by
selecting the Go Home command on the main View’s Op-
tions menu:

WorldFAQ again asks you if you want to change the system
clock. You can respond OK, or disable the clock reset by
tapping Don’t Reset the Clock. If you select OK, WorldFAQ
set the system clock back to the date and time for your
Home location.

Daylight Savings Time
Many countries around the world observe Daylight Savings
Time (DST). Daylight Savings Time starts and stops on
specific days at specific hours. When it starts, you are sup-
posed to set your clock ahead one hour. When it stops, you
are supposed to set your clock back one hour.

If you Home or Current location (which ever one is
active) observes Daylight Savings Time, and enters or leaves
it, WorldFAQ automatically resets your system clock prop-
erly at the appropriate hour. Like all other system clock
changes, you can tell WorldFAQ to notify you of the chang-
es and bypass the clock reset if you like.

Location Details
To see the detail view for a location tap its name. A second
screen appears showing you that location’s data. The details
that appear depend on the type of location you are looking
at. Some of the data you can edit, some is inherited from a
different location in the WorldFAQ database. For instance,
you cannot edit the telephone codes for dialing into and
out of Alexandria, Egypt when looking at the Alexandria
information. These codes are for all of Egypt. To change
them, you have to go to the Egypt detail view.

NOTE: When looking at a detail view, you can move to
the next and previous locations in the current category by
pressing your PalmPilot’s scroll down and scroll up buttons
respectively.

Time Zones
There are three pieces of information that WorldFAQ stores
for Time Zones (see Figure 15):

• The hours and minutes a time zone is offset from
Greenwich Mean (also called Zulu) time.

• The day that Daylight Savings Time starts and stops for
the time zone.

• The hour at which Daylight Savings Time starts (World-
FAQ assumes it stops one hour later it starts).

Time zone offsets are normally expressed as offsets from
Greenwich Mean Time in values between -12 and +12. A
few time zones also have partial-hour offsets of 15, 30, or
45 minutes. You can change the offset hour by entering a
new value between 12 and -12 in the offset data-entry field.
Tap on the minutes pop-up to select a partial-hour offset.

To change the Daylight Savings Time start and stop
dates and hour, you have to tap on the Daylight Savings
Time selector. A dialog box like the following appears:

Figure 15 - Time zone details.

Time zone offset

Daylight Savings Time
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By tapping on the dialog’s pop-ups, you can change the
start and stop dates and time. The Start and Stop pop-ups
display a list of all the dates currently used around the
world for starting and stopping dates:

Some of them are actual dates, most specify a particular
week during a month.

There are two special cases you may encounter when
editing time zone details. The first, a geographic region
with multiple time zones but a single Daylight Savings
Time rule, is shown in Figure 16. These are also called DST
Regions. You cannot change the time zones that are part of
the DST Region, but you can change the Daylight Savings
Time start and stop settings.

The second case, shown in Figure 17, is a situation
where a time zone is part of a larger geographic region,
such as a country, that has countrywide Daylight Savings
Time setting. For these situations, you can change the time
zone offset information, but you cannot change the Day-
light Savings Time rules. You have to go to the country for
that time zone to edit the DST information.

Countries
WorldFAQ stores more information for countries than it
does for time zones (see Figure 18):

• Name and two-character international country code
(non-editable).

• GMT offset (may be editable).
• Daylight Savings Time start and stop dates (may be

editable).
• Three-character currency code, the currency name, and

the exchange rate.
• Telephone codes you need to use to place a call into the

country and dial out from the country.
• Population.

Figure 16 - Multiple time tones.

Figure 17 - Country-controlled DST.

Figure 18 - Country details.
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Although you generally won’t want to, you can change all
these values except for the country name and code. The one
value that might change regularly is the exchange rate.

NOTE: To save memory space, WorldFAQ stores popu-
lation values in thousands, not in exact numbers. If you
enter 5,252 for a population value, for example, WorldFAQ
changes that value to 5,000. 5000 appears the next time you
look at that location’s Details.

Like time zones, there are some countries that have mul-
tiple time zones (see Figure 19). In these case, WorldFAQ
displays the words “Multiple Time Zones” and you are un-
able to change the GMT offset. You have to go to the time
zone detail view to do that.

There are also countries that are part of a larger geo-
graphic region and get their Daylight Savings Time start
and stop dates from that region (see Figure 20). To change
the DST start and stop dates, you have to change them for
the geographic region.

Islands
WorldFAQ treats islands as a hybrid of countries, time
zones, and cities. Like Guam, they may be part of a country
(the United States in this case) but have their own separate
time zone settings. Since they are small, they can also have
latitude and longitude as well. Islands may also be separate
political entities that use currencies from different counties.

WorldFAQ stores the following information for islands:

• Name and country affiliation (not editable).
• GMT offset.
• Daylight Savings Time start and stop dates (may be

editable).
• Latitude and longitude.
• Telephone dial-in and dial-out codes (not editable).
• Area code.
• Airport abbreviation and name.
• Population.

Although you generally won’t want to, you can change all
of these values except for the country name and code, and
the dial-in and dial-out codes.

In order to change the latitude and longitude, you have
to tap on the latitude/longitude selector shown in Figure
21. When you do, the following dialog appears:

Enter the correct values and tap OK to return to the island
details view.

Figure 19 - A country, multiple time zones.

Figure 21 - Island Details.

Figure 20 - A country, uneditable DST data.
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Islands may have their own GMT offsets and Daylight
Savings Time rules, or they may inherit them from other
countries. Figure 22 shows a case where both values are
inherited from other countries. In these situations, you
cannot directly edit the GMT offsets or DST values; you
have to go to the country they are inherited from to make
changes.

Cities
The lowest level of geographic detail stored by WorldFAQ is
the city. For each city, the program has the following infor-
mation (see Figure 23):

• Name and country (not editable).
• The time zone it’s located in (not editable).
• Latitude and longitude.
• Dial-in and dial-out telephone codes (not editable).
• Area code.
• Airport code and name.
• Population.

Like most WorldFAQ data, you probably won’t need to
change any of these values.

A city’s time zone may be the same as the country (as
shown in Figure 23) or it may be in a time zone within a
country as shown in Figure 24.

NOTE: Country capital cities are designated by a start to
the left of the city name as shown in Figure 23.

Adding Notes to Locations
You can add a text note to any WorldFAQ location by tap-
ping the Note button at the bottom of the location’s detail
view. When you do this, the Note screen appears (see Figure

Figure 23 - City Details.

Figure 24 - A city in a time zone.

25). You can use various techniques for adding and chang-
ing the Note information.

Figure 25 - The WorldFAQ Note screen.Figure 22 - An island with inherited time settings.
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Most easily, you can tap on a location on the Note and
enter text using the Graffiti keypad. You should be familiar
with this technique from using other PalmPilot applica-
tions. If you need assistance remembering specific Graffiti
strokes, you can make the Graffiti help screen appear (see
Figure 26) by selecting the Graffiti command from the Edit
menu.

As an alternative, you can use various clipboard com-
mands to manipulate chunks of text. You access these com-
mands from the Note screen’s Edit menu:

The clipboard commands do the following:

Undo Undo the previous clipboard command.
Cut Remove a selected block of text and places it on

the clipboard.
Copy Make a copy of the selected text and puts it on

the clipboard.
Paste Take the current contents of the clipboard and

inserts it at the current cursor location.
Select All Select all the text in the current data-entry

field, in this case, the Note.

A third method for entering and editing Note text is by
using the PalmPilot on-screen keyboard (see Figure 27).
You can make the keyboard appear by selecting the Key-

Figure 27 - The PalmPilot on-screen keyboard.Figure 26 - Graffiti help.

board command on the Edit menu. Read the appropriate
section of your PalmPilot documentation for more infor-
mation on how to use the keyboard.

NOTE: All these editing commands are also available for
changing WorldFAQ location data when working with the
various detail views.

Adding and Deleting Cities
With WorldFAQ, you can add and delete cities. To add a
city, use the main view to find a time zone, country, or
island that is closest to the city you want to add. Tap on that
location’s name so that its detail view appears. Select the
New City command on the Locations menu.

A new, partially-completed city detail view like the one
shown in Figure 28 on the next page appears. The main
difference between this view and a typical city detail view is
that the name field is blank, and the cursor is positioned
there. Fill in the name you want, change whatever other
data you want to change, and tap the Done button to save
the new city.

When creating a new city, WorldFAQ uses the starting
location you select to pass on as much information as pos-
sible to the new city, most importantly the country and
time zone. You want to pick a starting location as close as
possible to the city you are adding so that the new city has
the proper attributes. You can change many of the data
items, but you can’t change the time zone or country.
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NOTE: Once you tap OK to accept a new city, you can-
not go back and change its name. If you enter the wrong
name, you need to delete the erroneous city and reenter it.

To delete a city, either one that you’ve added or one that
came already included in the WorldFAQ database, first tap
that city’s name in the main view so that it’s detail view
appears. Then, select the Delete City command from the
Locations menu.

WorldFAQ will ask you to confirm that you want to delete
the city, and erase it if you tap the OK button.

Assigning Categories
Like all of the built-in PalmPilot applications, WorldFAQ
supports the notion of categories. Each location in World-
FAQ is assigned to one of 16 different categories. You can
view just one category’s locations, or view them all, by se-
lecting an appropriate choice on the Categories pop-up in
the upper right-hand corner of the main screen as shown
in Figure 29. You can also use this pop-up to add, delete,
and change category names.

WorldFAQ starts out with four categories – Time Zones,
Countries, Cities, and Islands. In addition, the PalmPilot
operating system adds another category called “Untitled”
that initially has no locations in it. You can add new catego-
ries, and delete and rename existing categories by selecting
the “Edit Categories” command on the Categories pop-up.
Refer to your PalmPilot documentation for details on
working with categories.

All WorldFAQ locations are initially assigned to one of
the four categories. You change the category for any loca-
tion by first going to its detail view. Like the main view,
each detail view has a Categories pop-up in the upper
right-hand category (see Figure 29). Use this pop-up to
change the category for any single location by selecting the
new category name, tapping the Done button, and then
tapping the OK button when WorldFAQ asks if you want to
save your changes.

You can add, delete, and rename category names using
the Detail View’s Categories pop-up. The important thing
to remember is that, when you click the Done button, if the
category showing in the upper right-hand corner of the
edit screen is different from the one the was visible when
you first entered the edit screen, you are changing the loca-
tion’s category.

NOTE: When you change a location’s category, World-
FAQ still keeps track of what type of location it is. A city is
always a city, no matter what category you put it in.

Figure 28 - Adding a city.

Figure 29 - The main view categories pop-up.

Figure 30 - Changing a location’s category.
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Setting Preferences
WorldFAQ has five preferences settings that let you custom-
ize its operation. When you chose the Preferences com-
mand on the main screen’s Options menu, the dialog
shown in Figure 30 appears. Change your preferences set-
ting using this dialog.

The WorldFAQ preferences are:

• Distance unit of measure. Select either Miles or Km
(Kilometers).

• Clock notification. Select this preference when you want
to have WorldFAQ notify you that it is about to change
the system clock. If you want to disable clock resetting,
you should have this preference turned on.

• Currency fractions. WorldFAQ can display currency
amounts and exchange rates with or without two digits
to the right of the decimal point. Selecting this prefer-
ence makes the fractions visible.

• Show days of the week. When viewing dates and times, if
this preferences is enabled, WorldFAQ displays the day
of the week instead of the two-digit year in the small
font view only.

• Preferences clearing. Select this option if you want to
restore WorldFAQ’s preferences to the state they were in
when you first installed the program. Home location,
view settings, and all other user-controlled choices are
cleared.

Backup and Restore
If, for some reason, you accidentally erase your copy of
WorldFAQ from your PalmPilot device, you can restore the
program in two steps. First, install your original copy of the
program file, WFAQ.PRC using the Pilot Desktop installa-
tion program.

Figure 30 - WorldFAQ preferences.

Second, you need to restore the WorldFAQ database.
Every time you make a change to the WorldFAQ database, a
backup copy is stored on your desktop system when you
HotSync. Because each Pilot Desktop application is a bit
different, we can’t tell you exactly where to find the backup
copy. The easiest method is to do a system-wide search on
your desktop for the file WFAQDB.PDB. That should con-
tain the latest version of your database file. To fully restore
WorldFAQ, reinstall that file on your PalmPilot device us-
ing the Pilot desktop program.

Getting in Touch With Us
WorldFAQ is a work in progress – we want to make it as
useful as possible. We’re already working on a list of en-
hancements for the next version. Your input is extremely
valuable to us. Please tell us about any features we can add
to make it a better product. Of course, report any bugs or
problems you may experience as well. The best way to con-
tact us is by e-mail at wfaq@cdpubs.com. You can also
reach us by telephone between the hours on 9 AM and 5
PM Pacific Daylight Time at 415.621.4252.

It’s difficult to create and maintain a comprehensive,
accurate database of international time zones, exchange
rates, telephone codes, and populations. For instance, it’s
almost impossible to get accurate population data for any
date past 1992. There are undoubtedly some errors in the
WorldFAQ data. We apologize in advance for any such
errors. If you discover any inaccurate data, please let us
know as soon as possible. We plan on maintaining a list of
errors on our Web site so that you can keep your World-
FAQ database up to date.

Finally, for the latest news and information about
WorldFAQ, we encourage you to regularly check our Web
site. We will be updating the program on a regular basis,
and we expect to be releasing other travel-related products
for the PalmPilot connected organizer.

Thank you very much for trying WorldFAQ. We hope
you like it.
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